
 Video VoxPhone Gold 2.0 User’s Guide                                  Page 1
User’s Guide Version: 12/07/00  9:44 AM



 Video VoxPhone Gold 2.0 User’s Guide                                  Page 2
User’s Guide Version: 12/07/00  9:44 AM

BY OPENING THE SEALED CD-ROM PACKAGE YOU ARE CONSENTING TO BE BOUND
BY THIS AGREEMENT.  IF YOU DO NOT AGREE TO ALL OF THE TERMS OF THIS
AGREEMENT, PLEASE RETURN THE WHOLE PACKAGE WITH THE UNOPENED CD-
ROM AND THE ACCOMPANYING PRINTED MATERIAL TO THE PLACE WHERE YOU
OBTAINED IT.

LICENSE AGREEMENT FOR VIDEO VOXPHONE TM  GOLD 2.0
Installation of  Video VoxPhone T M GOLD 2.0  (the "Product") is contingent on your (hereinafter
"Recipient") agreement to the following terms:

1. GRANT OF LICENSE.         Subject to the terms, conditions and limitations below, E-Tech
Canada, Inc. ("E-Tech Canada") grants to Recipient (and only Recipient) a limited, non-exclusive
license to use one copy of the executable code of the Product on a single CPU residing on Recipient's
premises. Recipient may only transfer the Product (and all (and only all) of his rights in the Product) to
an individual, provided that (i) such transfer is not for commercial purposes, (ii) the individual agrees to
be irrevocably bound by all the terms, limitations and conditions set forth in this Agreement.  All other
rights are reserved to E-Tech Canada.  Recipient shall not rent, lease, sell, sublicense, assign, or
otherwise transfer the Product, including any accompanying printed materials. Recipient may not
reverse engineer, decompile or disassemble the Product. E-Tech Canada shall retain title and all
ownership rights to the Product.

2. PRODUCT MAINTENANCE.      E-Tech Canada is not obligated to provide maintenance
or updates to Recipient for the Product. However, if E-Tech Canada should provide any maintenance or
updates, such maintenance or updates shall be covered by this Agreement.

3. DISCLAIMER OF WARRANTY.        Product is deemed accepted by Recipient. The
PRODUCT is provided AS IS WITHOUT WARRANTY OF ANY KIND. TO THE MAXIMUM
EXTENT PERMITTED BY APPLICABLE LAW, E-TECH CANADA FURTHER DISCLAIMS ALL
WARRANTIES, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NONINFRINGEMENT.
THE ENTIRE RISK ARISING OUT OF THE USE OR PERFORMANCE OF THE PRODUCT AND
DOCUMENTATION REMAINS WITH RECIPIENT. THIS DISCLAIMER OF WARRANTY IS AN
ESSENTIAL PART OF THIS AGREEMENT.  BECAUSE SOME STATES/JURISDICTIONS DO
NOT ALLOW THE EXCLUSIONS OF AN IMPLIED WARRANTY,  THIS DISCLAIMER MAY
NOT APPLY TO RECIPIENT AND RECIPIENT MAY HAVE OTHER LEGAL RIGHTS THAT
VARY FROM STATE TO STATE OR BY JURISDICTION.

4. LIMITATION ON LIABILITY.      UNDER NO CIRCUMSTANCES AND UNDER NO
LEGAL THEORY, TORT, CONTRACT, OR OTHERWISE, SHALL E-TECH CANADA OR ITS
AGENTS BE LIABLE TO YOU OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING,
WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE,
COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL
DAMAGES OR LOSSES, EVEN IF E-TECH CANADA SHALL HAVE BEEN INFORMED OF
THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.
THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR
PERSONAL INJURY TO THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION.
FURTHERMORE, SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION AND EXCLUSION
MAY NOT APPLY TO YOU.
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5. U.S. GOVERNMENT RESTRICTED RIGHTS AND EXPORT RESTRICTIONS.
The Product is provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the
Government is subject to restrictions as set forth in subparagraph c(1)(ii) of The Rights in Technical
Data and Computer Software clause of DFARS 252.227-7013 or subparagraphs c (1) and (2) of the
Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacturer is
E-Tech Canada, 100 Amber Street, Unit 8, Markham, Ontario, Canada, L3R 3A2.  Recipient
acknowledges that the Product licensed hereunder is subject to the export control laws and regulations
of the U.S.A., and any amendments thereof. Recipient confirms that with respect to the Product, it will
not export or re-export it, directly or indirectly, either to (i) any countries that are subject to U.S.A.
export restrictions (currently including, but not necessarily limited to, Cuba, the Federal Republic of
Yugoslavia (Serbia and Montenegro), Haiti, Iran, Iraq, Libya, North Korea, South Africa (military and
police entities), and Syria); (ii) any end user who Recipient knows or has reason to know will utilize
them in the design, development or production of nuclear, chemical or biological weapons; or (iii) any
end user who has been prohibited from participating in the U.S.A. transactions by any federal  agency
of the U.S.A. government. Recipient further acknowledges that the Product may include technical data
subject to export and re-export restrictions imposed by U.S.A. law.

6. GOVERNING LAW; ATTORNEYS FEES.      This Agreement shall be governed by the
laws of the Province of Ontario, Canada and Recipient further consents to jurisdiction by the province
and federal courts sitting in the province of Ontario. If either E-Tech Canada or Recipient employs
attorneys to enforce any rights arising out of or relating to this Agreement, the prevailing party shall be
entitled to recover reasonable attorneys' fees.

7. ENTIRE AGREEMENT.      This Agreement constitutes the complete and exclusive
agreement between E-Tech Canada and Recipient with respect to the subject matter hereof, and
supersedes all prior oral or written understandings, communications or agreements not specifically
incorporated herein. This Agreement may not be modified except in a writing duly signed by an
authorized representative of E-Tech Canada and Recipient.

8. THIRD PARTY BENEFICIARY.        E-Tech Canada, Inc. shall be deemed a third party
beneficiary of this Agreement.

One-Year Limited Warranty For The Telex  Nomad Computer Headset
The headset is warranted for one year from the date of purchase by E-Tech Canada Limited or the
distributor. It is free of defect in material and workmanship. In event of such defect, the product will be
repaired promptly without charge, or at our option, be replaced with a new product of equal value if
delivered to E-Tech Canada Limited, prepaid, together with the sales slip or other proof of purchasing
date. This warranty excludes defects due to normal wear and tear, abuse or failure to use product in
accordance with instruction. This warranty is void in the event of unauthorized repair or modification,
or removal or defacing of the product labeling.

Registration And Technical Support
All registered users are entitled to customer support, as well as notification of new product releases and
upgrades. Simply fill out and return the enclosed registration card.
For technical support, please call (905)479-9419 or E-mail: support@voxphone.com.
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Getting Started

Welcome to A New Form of Communications
Alexander Graham Bell, the father of the modern telephone kicked us into a technological
revolution, even he could never have seen coming. From the very beginnings of grainy,
static-filled conversations, to the pin-drop clarity of today, the telephone has come a long
way from Graham Bell's day.

The telephone is one of the greatest inventions of all time, enabling us to talk to our
neighbors next door, or our relatives on the other side of the world, simply and effectively.

Since Graham Bell's days the telephone hasn't changed much. Analogue pulse signals have
been replaced with digital beeps and buzzes, fiber optic cables have replaced older phone
wires, and Silicon Sally, the voice of voice-mail has become the most recognized voice the
world over.

Nothing since the invention of the telephone, not touch-tone, nor fiber optics, has
revolutionized communications like the Internet.

Swing step into a new era in communications. Alexander Graham Bell's telephone meets the
Internet. Introducing a new way to not only talk, but also a new way to see .

Conventional telephones were great for their time, but this is the Internet generation. Seeing
is believing and with Voice/Video over the Internet Protocol, you not only hear the person on
the other end, but you see that person too!

See the people you're talking to smile, cry, laugh, smirk, wink or just stare back at you -- as
they can see and hear you as well. Watch what you do -- you're on camera!

Using small, but powerful video/web cameras, Voice/Video over the Internet Protocol
bridges the communications gap, so that you can see who you are talking to.

Bigger bandwidths and faster computers have improved Voice/Video over the Internet
Protocols to the point where the sound quality is comparable to a normal telephone
conversation.

Our Video VoxPhone GOLD  software is the latest in the evolution of Voice/Video over the
Internet Protocol communications. Our software utilizes the most advanced voice and video
technologies, to enable crisp and clear communications over the Internet.

Thank you for purchasing Video VoxPhone GOLD and welcome, to a new and more
powerful way to reach out and touch the ones you love, work and play with.
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System Requirements

MINIMUM REQUIREMENTS             RECOMMENDED REQUIREMENTS
* Pentium 75 MHz PC                * Pentium 100 MHz PC or higher
* Windows 95/NT 4.0        * Windows 95/98/2000/NT 4.0 or higher
* 8 MB RAM                         * 16 MB RAM
* 5 MB free on your Hard Drive * 5 MB disk space
* 256-color monitor               * 256-color monitor
* 8-bit soundcard                 * 16-bit soundcard
* Microphone and speakers/headset   * Microphone and speakers/headset
* Winsock 1.1             * Winsock 1.1 or higher
* Internet access (direct or SLIP/PPP dial-up)       * Internet access (direct or SLIP/PPP dial-up)
* 14.4 kbps modem if using a dial-up connection * 28.8 kbps modem if using a dial-up connection

Installing Optional Hardware Bundles
Video VoxPhone GOLD is sold by itself, or bundled with various hardware components. To fully
configure Video VoxPhone GOLD with your new hardware, please install it prior to installing the
VoxPhone software.

Installing Headsets
The Telex Nomad headset included in some packages provides superior audio in a comfortable headset.
Insert the plug with the microphone symbol into the "MIC IN" of the soundcard, and then plug the
loudspeaker symbol into the "SPEAKER" jack.

Installing Microphones
The Telex VOICE Commander microphone included in some packages provides high quality audio,
while reducing background noise distortions. Insert the microphone plug into the “MIC IN” jack in
your soundcard.

Installing Webcams/Video Cameras for Use with Video VoxPhone GOLD
Follow the instructions which came with your webcam or consult the webcam’s manufacturer for
assistance.

A full-duplex soundcard and driver is needed for full-duplex
mode.
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Installation of Video VoxPhone TM GOLD from the CD-ROM

1. Insert the Video VoxPhone GOLD CD-ROM into your CD-ROM drive.
2. If you have autorun enabled in Windows, the Install Shield will automatically load. If not, just

click the Start button, then choose Run from the menu, then type:  x:\AutoRun.exe   (where x:
represents your CD drive) and
you’ll see the Install Shield’s
Welcome screen.

3. Click Next to begin the
installation.

4. Before installing the program,
you must  agree to the software
license. The software license
appears on your screen, after
reading it, click on Yes to
accept the terms and conditions
of the license and continue with
the installation. Clicking No
will end the installation.

5. You will be prompted for a
destination location – the hard
drive and directory on that hard
drive in which to place the Video VoxPhone GOLD software.  You can click on Next to accept
the default location, or click on Browse to view the file structure of your hard drive and select
where you’d like to place the program files. When you have selected the location for the program,
click Next to go to the next step.

6. All programs on your system are accessible from the Start menu, under the Programs menu.
Choose which program folder from the Programs menu Video VoxPhone GOLD’s icons will be
placed. You may select a folder, or simply click Next to use the default setting, which creates the
Voxphone Gold  v2.0 folder on your Programs menu. Once you have selected which folder to
place the program in, click Next to begin the installation.

7. The Install Shield will uncompress the program files to your hard drive. Once it is done, you will
be prompted to click on Finish to end the installation and return you to Windows.

8. When you first run Video VoxPhone GOLD, you will be prompted for your First and Last name
as well as the serial number included in your package. You must enter a valid serial number to
run and use the program. Do not give out your serial number. When Video VoxPhone GOLD
connects to the VoxPhone servers, it uses your serial number to identify you as a valid user. If
someone else is already using your serial number, you will not be connected to the server and you
will be unable to use the program.

9. After entering a valid serial number, the program will automatically run The Setup Wizard, after
an initial install.

You must uninstall any previous versions of
VoxPhone before installing this version.
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Installation of Video VoxPhone TM GOLD from the Internet

If you downloaded the latest version of Video VoxPhone GOLD from the Internet, before installing the
program you must first uncompress the install files.

1. Locate the executable (.exe) file which you downloaded on your hard drive.
2. From the Windows Start menu, click on Run.
3. Click on Browse or enter the drive path and file name of the location of the .exe file.
4. Click OK to run the install file.

5. The window at the left appears on your
screen.  Click on Setup to uncompress the
temporary install files to your hard drive.
6. After the files have been uncompressed,
the Install Shield will automatically load and
begin the installation of Video VoxPhone
GOLD.

7. Click Next to begin the installation.
8. Before installing the program, you

must  agree to the software license.
The software license appears on
your screen, after reading it, click
on Yes to accept the terms and
conditions of the license and
continue with the installation.
Clicking No will end the
installation.

9. You will be prompted for a
destination location – the hard drive
and directory on that hard drive in
which to place the Video VoxPhone
GOLD software.  You can click on
Next to accept the default location,
or click on Browse to view the file
structure of your hard drive and select where you’d like to place the program files. When you have
selected the location for the program, click Next to go to the next step.

10. All programs on your system are accessible from the Start menu, under the Programs menu.
Choose which program folder from the Programs menu Video VoxPhone GOLD’s icons will be
placed. You may select a folder, or simply click Next to use the default setting, which creates the
Voxphone Gold  v2.0 folder on your Programs menu. Once you have selected which folder to
place the program in, click Next to begin the installation.

11. The Install Shield will uncompress the program files to your hard drive. Once it is done, you will
be prompted to click on Finish to end the installation and return you to Windows.

12. When you first run Video VoxPhone GOLD, you will be prompted for your First and Last name
as well as the serial number included in your package. You must enter a valid serial number to
run and use the program. Do not give out your serial number. When Video VoxPhone GOLD

You must uninstall any previous versions of
VoxPhone before installing this version.
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connects to the VoxPhone servers, it uses your serial number to identify you as a valid user. If
someone else is already using your serial number, you will not be connected to the server and you
will be unable to use the program.

13. After entering a valid serial number, the program will automatically run The Setup Wizard, after
an initial install.

The Setup Wizard
The Setup Wizard automates the configuration process of Video VoxPhone GOLD, so that you can
easily and quickly start using the program. The Setup Wizard starts automatically the first time you
run Video VoxPhone Gold, however it can be run at anytime from the Video VoxPhone GOLD main
menu. The Setup Wizard will also automatically run if it detects a new soundcard, or codec.

The Setup Wizard helps you verify essential system components, adjust initial settings, and enter Video
VoxPhone GOLD user information. This section takes you step-by-step through the Setup Wizard,
however, if you ever want to run the Setup Wizard, just:

1. Go to the main Video VoxPhone GOLD screen.
2. Click on Help.
3. Click on Setup Wizard.

After you first install Video
VoxPhone GOLD, or when you
choose Setup Wizard from the Help
menu, you see the Setup Wizard’s
welcome screen (at left).

Navigating Through The
Setup Wizard
The Setup Wizard consists of several
steps which ensures Video
VoxPhone GOLD is configured for
peak performance on your system.
When you first run Video VoxPhone
GOLD, we suggest you follow the
steps in order. However, you can
page through the various steps, as the

chart below shows.

TO . . . DO THIS . . .
Go to the NEXT window Click on Next
Go to the PREVIOUS window Click on Back
SAVE setup information and EXIT Click on Finish from the last window
QUIT without saving setup information Click on Cancel at any time
Get HELP Click on Help or press F1

Setup Wizard – Step One: User Information Screen
To use Video VoxPhone GOLD, you must enter certain user information. This information is published
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in the online users directory so other users can call you. Any information you enter can be viewed by
other Video VoxPhone users in the
Call window.
This is the User Information
Screen (on the left). You can
change this information at any
time from the Tools menu, under
Options, or by using the Setup
Wizard.

You can TAB between fields – after
entering information in the required
field, simply hit the TAB key to go
to the next field.

The fields are described in more
detail below. Fields listed with an
asterisk ( * ) are required.

First Name*
Your first name. During a call, Video VoxPhone GOLD displays first and last names in the Session list
on the main Video VoxPhone Gold window.

If you publish your user information in the online directory, the name you enter is displayed in the
online directory in the Call window. Also, the search feature in the Call window uses first names to
find a user.

Last Name*
Your last name. During a call, Video VoxPhone GOLD displays first and last names in the Session list
on the main Video VoxPhone Gold window.

If you publish your user information in the online directory, the name you enter is displayed in the
online directory in the Call window.

Address
Your street or P.O. Box address, if you want to publish it.

City
Your city, town or village, if you want to publish it.

State
Your state, province, or territory, if you want to publish it.

Country
Your country, if you want to publish it. As Video VoxPhone users are from around the world, it is nice
to see what country someone is calling from.

Email*
Your email address. Video VoxPhone GOLD requires an email address to enable users to search for
your name in the Online Users directory. To be used with Video VoxPhone GOLD, your email address
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cannot exceed 47 characters.

Comment
Any remarks to help other users identify you, such as a note about special interests or hobbies.

Mail Server
Host name of the mail server used by your Internet email program for outgoing mail. If you do not
know the name of your SMTP server, ask your Internet Service Provider or system administrator
for the name of the SMTP server used for outgoing mail.

Your SMTP mail server information is required in order to send voice-mail successfully and to register
with web-based directory services.

Setup Wizard – Step Two: Audio Device Detection
The Audio Device Detection screen enables or disables full-duplex audio. In full-duplex, you can
transmit and receive voice simultaneously, just like a regular telephone. In half-duplex, you can only
transmit or receive—but not at the same time. Communications with half-duplex are similar to
communicating over a walkie-talkie.

The Audio Device Detection screen
is shown on the right.

If the Use Full-Duplex check box is
grayed, the Setup Wizard has
determined that your current sound
driver combination does not have
full-duplex capability. If this is the
case, you have several options:
♦ If full-duplex drivers are

available on your system, select
those drivers

♦ Contact your soundcard
manufacturer for full-duplex
drivers

♦ Use Video VoxPhone GOLD in
half-duplex mode

If you have more than one sound drive on your system, you’ll be able to pull-down from the Recording
and Playback pull-down menus to select the sound device drivers you wish to use. Select the sound
device drivers which are full-duplex, to use full-duplex operation.

In order to use the full-duplex capabilities of Video VoxPhone
GOLD, your soundcard and drivers must support full-duplex audio.
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Setup Wizard – Step Three: Audio Play Test
The Audio Play Test enables The Setup Wizard to set the volume levels correctly for audio playback.
In the Audio Play Test window (shown below), click on Play the Message . Video VoxPhone GOLD
responds by playing a pre-recorded message.

If you are unable to hear sound from
your computer's speaker system,
check the following items to
determine the cause of the problem:
♦ Ensure your speakers are

properly connected to your
soundcard.

♦ Ensure the speaker volume is
turned up.

♦ Ensure Video VoxPhone
GOLD's Speaker Volume is
turned up.

While adjusting the playback levels
you can adjust the volume by
dragging the slider either to the
left or the right.

When the playback volume is at a comfortable level, click on Next to go on to the next step.

Setup Wizard – Step Four: Audio Record Test
Similar to the Audio Play Test, the Audio Record Test adjusts the levels of audio properly for Video
VoxPhone GOLD, however, it is important to set the recording levels correctly, otherwise no one will
hear you talking. The Audio Record Test window is shown below.

Follow these steps to test the audio
recording performance and set the
recording level:
1.   Ensure your microphone is
properly connected to the soundcard
and the microphone is on.
2.   On the Audio Record Test
window, click on Record.
3.   In a normal and relaxed voice,
speak a sentence or two into the
microphone. A line of blue lights
will be displayed under the Record
Volume slider when it detects your
voice.
4.   Click on Stop Recording when
you want to stop recording your
voice.

5.   Click on Playback  to hear your voice played back through your computer speakers or headset.
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6.   If your voice sounds distorted, adjust the Record Volume and/or Speaker Volume sliders
      and repeat steps two through five.
7.  After the test, do one of the following:
♦ If you hear your voice over your speakers and are satisfied with the sound, click on  Next.
♦ If you do not hear your voice at all, select the I did not hear what I said checkbox and then

click on Next.

Setup Wizard – Step Five: Voice Activation Level
While running in "Hands Off" mode, Video VoxPhone GOLD can use Voice Activation to begin
recording and transmitting your voice automatically when you speak.

To help Video VoxPhone GOLD distinguish between your voice and background noise, the Setup
Wizard Voice Activation Level window requests information about the background noise level.
Background noise can be caused by many things, such as fans, electrical appliances, environmental
factors like heavy wind or rain, even other people in the room. If you are in an office with many other
people running around, chances are there is a lot of background noise. If on the other hand, you are in a
room in your own home, or a small office with a door, there is probably less background noise.

Although background noise is the primary factor in determining the voice activation level, another
factor is the relative sensitivity of your microphone setup. Some microphones are much more sensitive
to background noises than others. Information about the background noise helps Video VoxPhone
GOLD compensate for different noise levels and microphone sensitivities.

This is the Voice Activation window, in the Setup Wizard, which allows you to set the noise level for
your environment, so that your voice and your voice only, activates Video VoxPhone GOLD.

Setting The Noise Level
for Voice Activation
1. To set your environment for

voice activation, choose one of
the following:

♦ For a low background noise
setting, select My calling
environment is  quiet and click
on Next

♦ For a high background noise
setting, select My calling
environment is  noisy and click
on Next

♦ If you are unsure and want to
set the level interactively, select
I want to set the Voice
Activation level myself and go
to Step 2.

2. Ensure your microphone is positioned at a comfortable distance from you.
3. Click on Test.
4. In a normal and relaxed voice, speak into your microphone.
5. As you speak, notice the recording meter that extends from left to right. The length of the bar
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       corresponds to the audio level that is sensed by the microphone. The Voice Activation level
       determines how much sound it takes to activate the microphone. Moving the Voice Activation
       level slider to the left decreases the sound it takes to activate the microphone, moving the Voice
       Activation level to the right increases the sound it takes to activate the microphone.

To help you set the Voice Activation level, the Setup Wizard displays one of two messages above the
recording meter, depending on whether the microphone is activated:

      *   Unable to detect voice         or                *   Activated

6. Adjust the Voice Activation level so that background noise does not activate the microphone, but
       your speaking does.
7. When you are satisfied with the Voice Activation level, click on Stop Test.
8. Click on Next.

Setup Wizard – Step Six: Internet Connection Type
This is where you set your connection to the Internet in Video VoxPhone GOLD.  Video VoxPhone
GOLD will work under any connection to the Internet, however, the higher the bandwidth (essentially
the faster the connection) the better.

We recommend a 28,800 bps modem or greater if you plan to use the conferencing feature of Video
VoxPhone GOLD.

The Internet Connection Type window is shown below. To select your connection to the Internet:

1. Select the radio button that
reflects your connection type. If you
are unsure, select 14,400 bps or Less
Modem.
2. If you are using a Local Area
Network (LAN) connection, select
Greater than 28,800 bps (ISDN,
Network, etc.)
3. Click on Next.
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Setup Wizard – Step Seven: Performance Test
The performance test helps detect any potential problems that your computer may have in compressing
and decompressing audio data. It also evaluates your system's ability to perform adequately during both
normal and conferencing scenarios.

To begin the performance test, click
on Start Test.

After a few seconds, Video
VoxPhone GOLD will show you the
test results, along with any
suggestions to increase performance
during use.

After viewing the test results, click
on Next to proceed to the next step
in the Setup Wizard.

Setup Wizard – Step Eight: Phone Directories
There are various servers that maintain directories of Internet telephone users who are currently online.
You can set a default directory for publishing your name in Video VoxPhone GOLD. When you are
online and publish your name, other users who view this directory can see that you are online, this
allows your friends, family and co-workers to know you online and available for calls.

The Preferred Video VoxPhone Directory lists the available directories in which to publish your
name and other user information,
which you provided, such as your
city, town or village, country and
any comments you entered in the
comment field.

The directory you select becomes
your default directory. However, you
can always change which directory
you are listed in.

To make use of the enhancements
and added features of this version,
we recommend leaving the
Preferred VoxPhone Directory
option at the factory default setting,
which has been especially set for this
version.
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Setup Wizard – Step Nine: Setup Summary
This window summarizes the Setup
Wizard results.

♦ A blue checkmark indicates that a
test completed with acceptable
results.

♦ A blank gray box indicates that a
test was bypassed.

♦ A red checkmark indicates that a
test completed with unacceptable
results.

To redo any test, click on the button
next to that test. Click Next to go to
the final step.

Setup Wizard – Step Ten: Finish
Once all steps have been completed,
at the Finish screen, just click on
Finish to save all settings and exit
the Setup Wizard.  Alternatively, you
can click Back to go back to the
summary screen and redo any steps,
or you can click Cancel to exit the
Setup Wizard without saving any
settings.
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Welcome to Video VoxPhone GOLD

Features
Toss out your old, outdated conventional telephone, with Video VoxPhone GOLD you can do much,
much more:

♦ Full-duplex real-time computer-to-computer communications anywhere around the world without
any long distance charges

♦ Computer-to-regular telephone communications at a fraction of the cost of traditional phone-to-
phone long distance fees

♦ Full live-motion video so you can not only tell, but show the other party what you want to say
♦ Five party conferencing – make conference calls around the world
♦ Voice-email allows you to send voice-mail messages to email addresses worldwide
♦ Smart global online user lists and directories tells you when your friends, family and co-workers

are online
♦ Selectable codecs fine tune Video VoxPhone GOLD for your specific computer
♦ Automatic Gain Control (AGC)  to control voice input volumes
♦ Compliance to the H.323 standard, which ensures interoperability with many other Internet

telephone packages including:  VocalTec’s InternetPhone, Microsoft’s NetMeeting and others
♦ A Setup Wizard to make configuration a breeze
♦ Text chat modes for conversations with others without audio and video capabilities
♦ Voice activation makes communications easy and hands-free

In addition to these basic features, Video VoxPhone GOLD provides the following special
functionality:

♦ Call Blocking to accept or reject certain callers
♦ Caller ID to see who is calling
♦ Caller selection from a personal Address Book
♦ File transfer to send and receive files from other users
♦ Voice-mail allows you to leave voice messages to other users when they are away
♦ VoiceFonts™ which allow you to change your voice
♦ Superior technical support from E-Tech Canada – you can reach our technical support staff

anytime by sending us a voice-mail or regular email message to support@voxphone.com
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Video VoxPhone TM GOLD Main  Window
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Customizing Video VoxPhone GOLD – The TOOLS MENU
You can customize Video VoxPhone GOLD at any time from the main screen, by going to the TOOLS
menu and selecting Options.

The Options window contains the
following five tabs:

♦ User  -- Where all your user
information is entered and
stored.

♦ Directories -- Sets the
directories which Video
VoxPhone GOLD uses to
place your user information
(entered in the User section
mentioned above).  These
directories are also the ones
which Video VoxPhone
GOLD searches for online
users.

♦ Blocking -- For Call
Blocking which prevents
callers from getting through
to you.

♦ Audio --  Where you can configure and select soundcards and codecs for Video VoxPhone
GOLD.

♦ General -- Where general communications information is stored.

The five tabs are described in greater detail below.

User Options
You can change your Video VoxPhone GOLD user information. For example, you might want to
change your comments to reflect a new interest or hobby or use a nickname or handle which others
online will know you by.

The Users tab is shown above.  To change any of the User options:
1. From the Video VoxPhone GOLD main menu , select Tools then click on Options.
2. Go to the User tab.
3. Enter the information or changes to your user information.
4. When done click APPLY then click OK.

You must have a valid Internet email address set up.  The program will not
allow you to leave this window without entering an email address. To use the
voice-mail features of Video VoxPhone GOLD, you must have a functioning
SMTP mail server.
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Directories Options
The online user's directories contains a master list of currently active VoxPhone users. Video
VoxPhone GOLD creates the list from a collection of directories that you choose in your Directory
options.

You can make the following
selections on the Directories tab in
the Options window:
♦ The directory in which you
want Video VoxPhone GOLD to
publish your name.
♦ The online directories from
which Video VoxPhone GOLD is to
retrieve and display user
information.
♦ Whether or not to publish your
name automatically when you start
the program.

You can select the default calling
directories to publish your name and
the directories from which to retrieve

the names of other users:
1. From the Video VoxPhone GOLD main menu , select Tools then select Options.
2. Go to the Directories  tab.
3. Select how you want to publish your user information in online directories.
4. Select the directories you want retrieved and displayed in your online users calling list.
5. Click APPLY then click OK.

Blocking Options
Call blocking lets you automatically filter incoming calls based on a list that you set up in your call
blocking options. You can make the list instruct Video VoxPhone GOLD to only accept or reject calls
from the users contained in this list.

It is up to you how you want your call blocking handled by Video VoxPhone GOLD. If you only want
to talk to a chosen few, you’ll probably want to enter their names in the Blocking list and set Video
VoxPhone GOLD to only accept calls from those in your list. If, on the other hand, you want to allow
anyone to reach you – like an ordinary telephone – and only have a few users which you don’t wish to
talk to, you’ll probably want to enter those who you don’t want to talk with in your Blocking list and
set Video VoxPhone GOLD to not accept those in your list.

However you set your Blocking list, you must remember which way you arranged your list. If you
forget and start placing names in your Blocking list of users who you wish to accept calls from, yet you
told Video VoxPhone GOLD not to accept calls from those in your Blocking list, you’ll never be able
to talk to those users.

You can always check your Blocking options, from the main screen. Just go to Tools then go to
Options then click on Blocking.
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Once your call blocking options are set, you can turn call blocking on or off from the main window. To
set your blocking options:
1. From the Video VoxPhone GOLD main menu , select Tools then click on Options.
2. Go to the Blocking tab.
3. Do one of the following:

♦ To make a list of users to exclusively accept calls from, select Block all users NOT  
     CONTAINED in the user list.

♦  To make a list of callers to exclusively reject calls from, select Block all users
CONTAINED in the user list.

4. Under the User List, do one of the following:
♦ To add names to the list, enter the first and last name of a caller and click on Add.
♦  To delete names from the list, highlight a name in the User box and click on Delete .
5. Continue adding or deleting names from the list until you are done.
6. Click on APPLY then click OK.

Your Call Blocking User List can be set up either as a list of users to accept calls from, or as a list of
users to not accept calls from. If you originally set your User list to be one to reject calls and you place
users which you’d like to receive calls from on your list, those users who you want to talk with won’t
get through. The opposite is also true if your list is setup as one to accept calls and you place those who
you don’t want to talk to in your list, those who you wish to block from calling will get through. Make
sure you place the correct type of users in your Blocking list.

Audio Option
The Audio Option allows you to
select soundcards, drivers and codecs
available for use on your particular
system.

If the current soundcard driver does
not support recording, playback, or
full-duplex, you can select a
different driver – if available on your
system. The Audio tab in the Options
window lists the currently available
soundcard drivers on your system.
To change soundcard drivers:
1. From the Video VoxPhone
GOLD main menu, select Tools
then click on Options.
2. Click on the Audio tab.

3. From the Microphone list, select a soundcard driver.
4. From the Speaker list, select a soundcard driver.
5. Click on APPLY then on OK.

Selecting Full-Duplex Or Half-Duplex
Full-duplex allows you to listen and talk at the same time and allows for more natural conversations.
Since not all soundcard/audio driver combinations support full-duplex, Video VoxPhone GOLD also
supports half-duplex operation.
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If the Full-Duplex checkbox is disabled in your Audio Options, it is likely that your current microphone
and speaker driver combination does not support full-duplex mode. Check your soundcard
documentation for more information.

To change from half-duplex to full-duplex:
1. From the main Video VoxPhone GOLD window, click on Hang Up to end any active sessions.
2. From the Video VoxPhone Gold main menu , select Tools then click on Options.
3. Click on the Audio tab.
4. Select the Enable Full-Duplex checkbox.
5. Click on APPLY then click OK.

Selecting A Codec
Video VoxPhone GOLD
currently supports several
codecs. A codec is a
COmpressionDECompression
algorithm which compresses
and decompresses the data
while being sent over the
Internet. The more powerful
the codec, the faster the data
travels. The best codecs
provide the best quality audio
and video. The codec to select
as your preference depends on
the specific configuration of
your computer. The codec
actually used during a call
depends on a number of factors, including the codec selected as the preferred codec by other parties in
your conversation. You can check the codec used by another caller by clicking on the Time column in
the Session list. Clicking on the Time column toggles between the Codec or Type column.

Use the list below to select the codec that is right for you and your computer.
Codec Description
RT24 V2.0 E-Tech Canada’s low bandwidth, basic 8KHz MetaVoice codec
RT28 E-Tech Canada’s low bandwidth, high quality MetaVoice codec. Requires a slightly higher

bandwidth than the RT24, but less than the RT29 and delivers superior sound quality.
Recommended for Video VoxPhone to Video VoxPhone calls.

RT29 V2.0 E-Tech Canada’s high quality 8 KHz MetaVoice codec. Requires more system resources than
RT24 and slightly higher bandwidth than RT28, but delivers very high sound quality.

G.711 u-law Complies with the H.323 standard for Internet telephone interoperability. Recommended for high
bandwidth connections at or above 64 kbps, such as on a Local Area Network (LAN) or a T1 line.

G.711 A-law Complies with the H.323 standard for Internet telephone interoperability. Recommended for high
bandwidth connections at or above 64 kbps, such as on a Local Area Network (LAN) or a T1 line.

G.723.1 Complies with the H.323 standard for Internet telephone interoperability.

In order to use the full-duplex capabilities of Video VoxPhone
GOLD, your soundcard and drivers must support full-duplex audio.
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To select the codecs for your system:

1. From the Video VoxPhone GOLD main menu, select Tools then click Options.
2. Go to the Audio tab.
3. Under the Compression area, select a codec from the Preference drop-down  list.
4. If you want to assign an order for preference to the available codecs, click on Advanced and

adjust the list (shown at right).
5. Click on OK in the Advanced Compression Properties list, (if you are on that screen) then click

Apply.
6. Click OK.

Other Audio Options

Adjusting the Playback Delay
The value of Playback Delay can range from 0 to 2 seconds and is set using a slider bar.
1. From the Video VoxPhone GOLD main menu , select Tools then click on Options.
2. Click on the Audio tab.
3. Under the Other Settings area, adjust the Playback delay slider.
4. Click on APPLY then click OK.

You may need to repeat these steps until you get the playback delay setting you like.

Adjusting The Pause Window
The value of the Pause Window can range from 0 to 2 seconds, and is set using a slider bar in the
Options window.
1. From the Video VoxPhone GOLD main menu , select Tools then click on Options.
2. Click on the Audio tab.
3. Under the Other Settings area, adjust the Pause window slider.
4. Click on APPLY then click OK.

Adjusting Echo Cancellation
You can adjust the Echo Cancellation between low and high using a slider bar in the Options window.
1. From the Video VoxPhone GOLD main menu , select Tools then click on Options.
2. Click on the Audio tab.
3. Under the Other Settings area, adjust the Echo Cancellation slider.
4. Click on APPLY then click OK.

You may need to repeat these steps until you get the echo cancellation setting you like.

Enabling and Disabling Sounds
Video VoxPhone GOLD features a number of phone sounds:

*   Dial tone           *   Incoming ringer           *   Outgoing ringer

These sounds are enabled by default. However, if you want, you can disable them.
1. From the Video VoxPhone GOLD main menu , select Tools then click on Options.
2. Click on the Audio tab.
3. Do one of the following:

♦ To enable sounds when a checkmark is not displayed in the Enable phone sounds
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checkbox, select Enable phone sounds
or

♦ To disable sounds when a checkmark is displayed in the Enable phone sounds
checkbox, select Enable phone sounds

4. Click on APPLY then click OK.

General Option
The General Option allows you to set the number of rings before Video VoxPhone GOLD
automatically rejects a call, your Internet connection type and the directory for file transfers.

Setting the Incoming Call Reject
Time
You can indicate how long Video
VoxPhone GOLD is to wait for a
response from you before
automatically rejecting an incoming
call. You set this in your general
preferences.
1. From the Video VoxPhone
GOLD main menu, select Tools
then click on Options.
2. Click on the General  tab.
3. Enter the number seconds
between 0 and 60 that you want
Video VoxPhone GOLD to wait for
a response in the Number of
seconds before automatically

rejecting incoming call field.
4. Click on APPLY then click OK.

Changing Your Internet Connection Type
Video VoxPhone GOLD requires information about your Internet connection type.
1. From the Video VoxPhone GOLD main menu , select Tools then click on Options.
2. Click on the General  tab.
3. Under the Internet Connection Type  area, select the speed of the modem you are using. If you

are unsure, select 14,400 bps.
5. Click on APPLY then click OK.

Customizing Video VoxPhone GOLD – The PHONE MENU
You can enable or disable the following features in the Phone Menu
       *  Hands Off
       *  Auto Answer
       *  Block Call
       *  Publish Name
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You can also place calls, hangup on the current conversation, make conference calls and send voice-
mails from this menu. These options will be discussed later, in the Using Video VoxPhone GOLD
section.

To enable or disable Hands Off, Auto Answer, Block Calls, or Publish Name, simply click that option.
If the option is enabled, a checkmark appears next to it, if it is
disabled, there is no checkmark. If that option is unavailable, it
will be grayed out.

These options are described in greater detail below.

Hands Off
If you are using a soundcard in half-duplex mode, you must
take turns talking and listening to the other party, similar to a
CB or a walkie-talkie. While in half-duplex mode, you must
press the TALK button to talk to the other party (a TALK
button appears on the main screen when in half-duplex
operation).

The Hands Off option allows you to talk hands-free in half-
duplex mode. You still must wait for the other party to stop
talking, before you can talk, but in Hands Off mode, Video
VoxPhone GOLD will automatically send your audio when you
talk, through Voice Activation of the microphone. This way,
while in half-duplex mode, you won’t have to continuously

                                                               press the TALK button to talk.

You can check to see if your soundcard and driver combination supports full-duplex mode, by going to
the TOOLS  menu, then selecting Options. From the Options menu, select Audio. If the Enable full-
duplex checkbox is checked, you are in full-duplex mode. If it is grayed out, your current audio
configuration does not support full-duplex and you are in half-duplex mode.

Auto Answer
Auto Answer mode will automatically answer all incoming calls, the phone will ring once – if you have
sounds enabled and the call will automatically be connected. To enable or disable sounds, from the
Video VoxPhone GOLD main screen, select Tools then click on Options. Click on the Audio tab. If
there is a checkmark next to the Enable phone sounds  checkbox, sounds are enabled. If there is no
checkmark, sounds are disabled. To enable or disable sounds, click in the Enable phone sounds
checkbox.

Hands Off mode is unavailable in full-duplex mode, as it
isn’t required. In full-duplex mode, all parties can talk at the
same time, just like a regular telephone conversation.

In order to use the full-duplex capabilities of Video
VoxPhone GOLD, your soundcard and drivers must support
full-duplex audio.
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Enable Block Calls
This option works in conjunction with the Blocking menu shown below.

You can set the Blocking menu at
the left to be either a list of users
from which to accept calls, or
reject calls.

If you have the Accept the
following users only checkbox
selected, then when you enable
Block Calls  from the Phone Menu,
only those users named in your
Blocking list will be able to call
you.

If you have Block the following
users  checked, then enabling
Block Calls  from the Phone Menu
will prevent only those listed in
your Blocking list from calling
you, all other users will be able to
call you.

If you have Block Calls enabled in the Phone Menu and Accept the following users only checked in
the Blocking menu, but you have no users listed in the Blocking menu, no one will be able to call you .
This is useful if you want to block all calls from getting through.

To go to the Blocking menu, from the Video VoxPhone GOLD main screen, select Tools then click on
Options.  Select the Blocking tab to view and/or edit your Blocking list.

Enable Publish Name
When enabled, the information you entered in the USER menu will be displayed to all VoxPhone users
worldwide. When disabled, no one will see your user information and no one will no that you are
online.

To view and/or edit your User information, from the Video VoxPhone GOLD main screen, select Tools
then click on Options.

Customizing Video VoxPhone GOLD – The VIEW MENU
The View Menu allows you to customize the views of the main Video VoxPhone GOLD screen. By
selecting or de-selecting options, these items will either be displayed or they won’t be displayed, on the
main screen.

Each option is described below.
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Features
When checked, the feature buttons Text Chat, Video and Voice Mail  are displayed. These buttons are
not displayed if the Features option is not selected in the View menu.

Audio Controls
The microphone, speaker and Automatic Gain Control (AGC) options are displayed on the main screen,

when this option is checked.

Status
Controls whether or not the status window at the very
bottom of the Video VoxPhone GOLD main screen is
displayed. The status window is useful for new users, as it
provides short explanations of what you are pointing to –
when you move the mouse over anything on the main screen,
a short description appears in the status window.

Announcements
Next to the E-Tech Canada logo is the Announcement
Window. From time-to-time, we’ll send out broadcast
messages to all users about updates, new products and
services. When there aren’t any announcements, clicking in
the Announcement Window will take you to the VoxPhone
website.

Address Book
By checking this option, your local Address Book will be

displayed to the right of the Video VoxPhone GOLD main screen, allowing you to see when your
friends, family or co-workers are online.

Show All
When checked, all the options in the View Menu are displayed.

Show None
When checked, none of the options in the View Menu are displayed, except the Announcements
Window, which remains visible.

Save/Restore Desktop
When checked, saves your current view settings when you exit and will restore them when you re-start
the program. If unchecked, all view settings return to the default or last saved values.
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Using Video VoxPhone GOLD

Starting Video VoxPhone GOLD
Once you have an online connection to your Internet Service Provider, you can start Video VoxPhone
GOLD. Video VoxPhone GOLD automatically publishes your name in an online directory (if
automatic publishing is set in your preferences). Publishing your name lets other people know you are
available to accept calls.

To Start Video VoxPhone GOLD  go to your Start menu. From the Programs option go to the
VoxPhone GOLD item and click on PC-To-PC. If you are subscribed to an Internet Telephone Service
Provider (ITSP) and you would like to make a call to a regular telephone, select PC-To-Phone.
Alternatively, if you have created a shortcut on your desktop, just click the Video VoxPhone GOLD
icon to load the program.

Placing Calls
There are several different ways that you can place a call:
1. Select and call a user from Video VoxPhone GOLD’s online users list.
2. Select and call a user from your local Address Book.
3. Enter a user’s email or

Internet Protocol (IP)
address and place a direct
call.

Each way to make a call is
described in detail below.

Placing Calls – From the
Online Users List
You can make calls from the
Online Users List, by simply
selecting a VoxPhone user and
clicking Dial . Alternatively,
you can double click any user
and Video VoxPhone GOLD
will dial that person.

You must be using an Internet Telephone Service Provider (ITSP) to make
calls from Video VoxPhone GOLD to regular telephones. If you are unsure
ask your Internet Services Provider or system administrator.

All PC-To-Phone services are provided by Net2Phone. If you experience
any difficulties with the PC-To-Phone plug-in, please contact Net2Phone
customer support toll-free at 1-800-438-8879.
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To get to the Online Users List, from the Video VoxPhone GOLD main screen, select Phone then click
on Call .

To learn more about a particular VoxPhone user online, select that user from the Users Online List and
then click Details . Any information that person has entered in their User profile, from the User menu
will be displayed.

You can add users from the Online Users List to your local Address Book, by selecting a user and then
clicking Add to local .

Video VoxPhone GOLD automatically refreshes the Online Users List every few minutes, but if you’d
like to manually update the list, just click on Refresh.

Placing Calls – From Your Local Address Book
To make calls from your local
Address Book, simply select a
VoxPhone user and click Dial .
Alternatively, you can double click
on that user and Video VoxPhone
GOLD will begin to dial that
person.

You can access your Address
Book in two ways. First, by
selecting Address Book from the
View Menu from Video
VoxPhone GOLD’s main menu.
The other way is to click on Local
Address Book from the Online
Users List.

When you view your Address Book from the View Menu, you can dial and refresh the information,
however you cannot add, delete or edit users from this screen. To add, delete or edit entries in your
Address Book, you must access your Address Book from the Phone menu through the Online Users
List.

To modify any user entries in your Address Book, from the Local Address Book screen under the Call
menu, click the corresponding button – either Add, Delete  or  Edit. More detailed information on your
local Address Book follows in the Using Your Address Book  section.

Placing Calls – Directly
If you know the email or Internet Protocol (IP) address of the person you wish to call, you may call that
person directly by clicking on Direct Call from the Call menu. You can reach the direct dial screen
from the Video VoxPhone GOLD main screen by selecting Phone then clicking on Call. Now click on
Direct Call . You can only enter an email address to directly dial another VoxPhone user, otherwise,
you’ll have to enter that person’s IP address.
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Placing Calls – Dial Button
You can place calls in any of the three ways mentioned above, by simply clicking the Dial  button, if
you have the Features option selected from the View  Menu.

Using Your Address Book
Your local Address Book contains a list of users who you expect to call frequently. You create and
store the list locally on your computer. You can use this list to store specific information about callers
(their names, locations, comments, etc.) You can also place calls from the list.
To place calls directly from the Address Book, the following fields must contain information:
       *  First Name
       *  Last Name
       *  Email or Internet Protocol (IP) address
          (enter an IP address only if the user has a static IP address)

Placing A Call From Your Local Address Book
You can easily place a call from
your local address book.
1. From the main Video

VoxPhone GOLD screen,
click on Call to display the
Call window.

2. Go to the Local Address
Book tab.

3. Select a user to call.
4. Click on Dial .

Video VoxPhone GOLD places
the call using either the person’s
email or static IP address listed
in your local address book.

Automatically Adding
Callers to Your Address Book
You can easily add a caller to your local address book without entering the information manually.
1. From the main Video VoxPhone GOLD window, click on Call to display the Call window.
2. Go to the Online Users List tab.
3. Highlight the name of the user to add to your local address book.
4. Click on Add to local .
5. Click OK, a message will popup indicating the user was added to your local address book.
6. Click on Cancel to exit the Call window.

Because there is no way of checking whether the user’s Internet Protocol (IP) address is static or
dynamic, Video VoxPhone GOLD does not save the IP address.  Dynamic IP addresses change every
time the user logs onto the Internet. This prevents saving an IP address for a user that may have
changed since you last called from the Address Book.
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Adding Callers to your Address Book Manually
You can manually add a caller to your local Address Book.
1. From the main Video VoxPhone GOLD window, click on Call to display the Call window.
2. Go to the Local Address Book tab.
3. Click on Add.
4. On the Address Book Entry window, enter information as needed.
5. Click on OK.

Updating Caller Information in Your Address Book
To update your Address Book:
1. From the main Video VoxPhone GOLD window, click on Call to display the Call window.
2. Select Local Address Book.
3. Select the user information  you want to change.
4. Click on Edit.
5. In the Address Book Entry window, update information as needed.
6. Click on OK.

Deleting Callers Information from your Address Book
To delete users in your local Address
Book:
1. From the main Video
VoxPhone GOLD window, click on
Call  to display the Call window.
2. Select Local Address Book.
3. Select the person you want to
delete from the list.
4. Click on Delete  and then on
Yes to confirm the deletion or No to
abort the deletion.
5. Click on Cancel to exit the Call
window.

Voice-Mail
Voice-mail allows you to record a voice message and send it to another person using email. Voice-mail
also allows you to send a text message. A single email can contain the following:
     *  A voice message only          *  A text message only           *  Or voice and text messages together

Voice Messages
Your recorded voice message is stored in a .VOX file that is sent as an email attachment. The person

You must enter a first and last name as well as a valid email
address to successfully add users to your local Address Book.
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who receives the email plays the file using a helper application capable of playing .VOX files, such as
our ToolVox Player. The ToolVox player is included in the CD-ROM. You can install the program on
your hard disk or you can download a free version of the ToolVox Player from E-Tech Canada’s
VoxPhone website at: http://www.voxphone.com.

Setup for Voice Messages
To play and hear voice messages, the person’s PC should be set to play sound. This means that the
person should have a PC, soundcard, and speakers that are set up and in working order. The PC must
also have a helper application which is capable of playing a .VOX file, which is the voice message file
format for Video VoxPhone GOLD’s voice-mails.

Who Can Receive Voice-Mail?
Because voice-mail is sent via Internet mail servers, anyone who has an Internet email address can
receive voice-mail. The setup of the receiving person’s PC determines the voice-mail parts that can be
accessed.

When Can I Use Voice-Mail?
You can use voice-mail at any time. Typically, you use voice-mail under the following conditions:
♦ A caller is online, but is not accepting calls.
♦ A caller is offline and cannot be reached.
♦ You want to leave a message without talking to the other caller.
♦ You want to leave a message for someone who has email, but not an Internet telephone

application.

Recording and Sending A Voice-Mail
You can easily record and send voice-mail to another caller. The recorded voice-mail is stored in a
.VOX file that the other person receives in an email file attachment.

1. From the Video
VoxPhone GOLD main
screen, select Phone,
then click Voice Mail.

2. In the To field, enter the
email address of the
person to whom you want
to send a voice message,
if the email address is not
already displayed. You
can easily enter the email
address of a person by
selecting the person’s
name from the Online
Users List or Local
Address Book on the Call
window while the Voice
Mail window is displayed. (To access the Call window, select Phone then click Call.)

3. If you want to send the voice-mail to other people at the same time, enter the email address in the
Cc (Carbon Copy) field. Separate multiple email addresses with a comma.
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4. In the Subject field, enter the topic of the email.
5. Click on the Record button and begin speaking into your microphone.
6. Click on the Stop button to finish recording your voice message.
7. To listen to your message before you send it, click on the Play button.
8. If you want to send a text message with your voice message, click on the Text Message  button

and type the text.
9. Click on Send to send your message.

Playing Voice-Mail
To play a voice-mail directly from email, you must have a helper application set up that is capable of
playing a .VOX file. The ToolVox Player is the helper application that comes with Video VoxPhone
GOLD.

To play and hear voice-mail requires the following to be set up:
*  Soundcard
*  Speakers connected to a PC and in working order
*  A helper application that plays .VOX files

For more information about setting up helper applications, refer to your email documentation.
To Play the voice-mail:
1. Open the email.
2. Click on the file attachment to play the voice message.

Some email systems may require you to download the file before playing it.

Text Messages
Voice Messaging also allows you to type and send a text message. This allows you to enter any
comments you might want to send with the voice message. Alternatively, you may send just a text
message. A text message is displayed in the body of the email rather than in a separate attached file.

To send a text message:
1. From Video VoxPhone GOLD’s main screen select Phone then click on Voice-Mail.
2. In the To field, enter the email address of the person you wish to send the message to. If you want

to send the message to more than one person, enter the other email addresses, separated by
semicolons in the Cc field.

3. Type the topic of your message in the Subject field.
4. Click on Text Message .
5. Enter your message in the message window which popped up.
6. Click on Send to send your message or click Cancel to abort.

Using Text Chat
The Text Chat feature displays a window for text-based communication. If there is a bad audio
connection, Text Chat could be used to verify or communicate critical information.

To begin a text-based chat:
1. If you do not have an active connection with the other user, place a call.
2. From the main Video VoxPhone GOLD screen, click on Text Chat.
3. In the Outgoing Dialog, type in your message.
4. Click on Send. Video VoxPhone GOLD notifies the recipient of the Text Chat session by opening
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the Text Chat window automatically, if not already opened.
5. To remove all of the information in the Text Chat window, click on Clear.
6. To end your Text Chat, click on Close.

Voice Fonts
You can change the way your voice sounds by using VoiceFonts. Individual VoiceFonts are grouped
together into VoiceFont families.
You have to enable VoiceFonts before using
them.
1. From the main Video VoxPhone

GOLD screen, select Tools then click
VoiceFonts.

2. Select the Enable radio button.
3. Select a VoiceFont Family from the

VoiceFont Family drop-down list.
4. Select a VoiceFont from the list.
5. Click on APPLY then click OK.

Video VoxPhone GOLD displays "V-Fonts"
in the LCD area of the main screen to
remind you that you have a VoiceFont
applied to your voice.

Testing VoiceFonts
You can test how a VoiceFont changes the
way your voice sounds before using it. Individual VoiceFonts are grouped together into VoiceFont
families. Follow the process below to test VoiceFonts.

1. Select a VoxPhone MetaVoice codec.

2. From the main Video VoxPhone GOLD screen , select Tools then click VoiceFonts.
3. Select the Enable radio button.
4. Select a VoiceFont Family from the VoiceFont Family drop-down list.
5. Select a VoiceFont from the list and click on Apply then click OK.
6. Call Yourself.  To do this, from the main screen, click on Phone. Then go to the Online Users

Listing and select yourself from the online list. (You must Enable Publish Name  from the Phone
menu to call yourself.)

7. Start talking to yourself to hear how the VoiceFont sounds with your voice.
8. Repeat steps 4 through 7 to test how you sound with other VoiceFonts.
9. Do one of the following:
                *   To close the Video VoxPhone GOLD VoiceFont window without  applying a VoiceFont,
                      select the Disable radio button. Then click on APPLY and then OK.

*    To apply a VoiceFont to your voice, select the VoiceFont to be used and click on  Apply,
           then click on OK.

Make sure you have a MetaVoice codec set up in your Audio options.
See Selecting a Codec for instructions. VoiceFonts only work with
MetaVoice codecs.
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If you apply a VoiceFont, Video VoxPhone GOLD displays "V-Fonts" in the LCD area of the main
Video VoxPhone GOLD window to remind you that you have a VoiceFont applied to your voice.

Disabling VoiceFonts
You can turn VoiceFonts off if you no longer want a VoiceFont applied to your voice.
1. From the main Video VoxPhone GOLD window, select Tools then click VoiceFonts.
2. Select the Disable radio button.
3. Click on APPLY then click OK.

Answering A Call
Video VoxPhone GOLD  allows you to place and receive multiple calls. A call can be thought of as a
session. Video VoxPhone GOLD lists each session on the main window. Each call session is
designated by a telephone icon. A session can be in any of the following states:

Status Description
Blocked Indicates the other user's blocking preference has

prevented a connection.
Conference You are participating in a conference call.
Failed Indicates the loss of a network connection between you

and the other user.
On Hold You are connected to another user and the other user has

switched to another session.
Ready You are connected to another user, but not transmitting

or receiving.
Recv You are receiving information from another user or

conference of users.
Xmit You are transmitting information to another user or

conference of users.
Xmit/Recv You are transmitting and receiving information from

another user or conference of users.

Using Auto Answer
If Auto Answer is on (enabled), Video VoxPhone GOLD automatically answers the call after one ring
and then displays it in your Session list. Video VoxPhone GOLD also displays “AutoAns” in the LCD
area of the main Video VoxPhone
GOLD screen.

If Auto Answer is off (disabled), a
message is displayed to alert you
about the incoming call. You may
accept the call by clicking on
Accept or reject it by clicking on
Reject. If you do not respond to
this message within the number of
seconds specified in your General
Options, Video VoxPhone GOLD
automatically notifies the caller
that there was no answer.
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Conference Calling
Video VoxPhone GOLD allows you to group several individual sessions into one session called a
conference. Establishing a conference connects all callers together. There may be a maximum of five
participants in a conference call.

To make a conference call:
1. Make the first call.
2. Repeat Step 1 for as many people you wish to invite to the conference.
3. From the main Video VoxPhone GOLD screen , click on the Conference button or you can go to

the Phone menu and select Conference.
4. On the Conference Manager window, click on the Create New radio button.
5. Under Conference Name, enter the name you wish to refer to for this conference.
6. From the list of Available Users, select a user who you would like to participate in your

conference and click Add.
7. Repeat Step 6 to add other users to the conference. Including yourself, there can be up to five

participants in the conference at any one time.
8. Click on OK to begin the conference.

Adding a User to Conference Call
Once a conference call is established, any participant can add additional users to the conference. There
can be a maximum of five participants in a conference call. To add users to a conference call already in
session:
1. From the main Video VoxPhone GOLD window, click on Conference.
2. On the Conference Manager window, click on the Add to Existing radio button.
3. From the drop-down list, select the conference to which you want to add users.
4. From the list of Available Users, select a user who you would like to participate in your

conference call. Click Add to add the user to the list of Users in Conference.
5. Click OK.

Removing a User from a Conference Call
Once you are a participant in a conference call, you can remove other users from the conference.
You can remove a user who has "new" next to their name. You cannot remove a user who previously
joined the conference and has "joined" next to their name.

To remove a user from a conference call:
1. Select the conference  from which you want to remove a user.
2. Under the Users In Conference list, highlight the name of the user to remove.
3. Click on Remove .

Ending A Conference Call
You can end your conference call at any time:
1. Select the conference to end.
2. Click on Hang Up.

Hanging up on a conference simply removes you from the conference. Hanging up on a conference call
does not necessarily end the conference. As long as there are two people connected, the conference
remains.
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Multiple Calls
Video VoxPhone GOLD allows you to place and receive multiple calls. When you have multiple
calling sessions, Video VoxPhone GOLD lists each call in the Session list in the main Video VoxPhone
GOLD window. In the Session list, each call is designated by a phone icon (for Video VoxPhone
GOLD calls) or an H.323 icon (for H.323 calls made to other Internet telephony applications). You can
switch between calls by clicking on the icon.

Since you can only have one active call at any one time, switching from one call to another has the
effect of placing the previous call on hold. Calls that you have placed on hold by switching calls have a
status of Ready on your end and On Hold on the other end.

To make more than one call:
1. Place the first call. Let the caller know you will be placing them on hold.
2. Place the second call and begin speaking to the second caller as soon as the call is established.
3. To switch to the previous call:
♦ Let the second caller know that you will be placing them on hold.
♦ Select the previous caller from the Session list on the main Video VoxPhone GOLD                       

window.

The call you just left has a status of Ready and your present call is now active.

File Transfer
You can send a file to another Video VoxPhone GOLD user during a call.

Sending A File
To send a file:
1. If you do not have an active

connection with the other user,
place a call.

2. From the main Video VoxPhone
GOLD screen, select TOOLS  then
click on File Transfer.

3. Select a user from the Send the file
To list in the File Transfer Send
window.

4. In the Local File Name field, enter
the name and path of the file you
wish to send. If necessary, click on
Browse to find the file on your
system.

5. Click on Send to send the file or
click on Abort to cancel the
operation.

You cannot transfer a file to more than one user at a time. If you wish to send a file to all participants of
a conference that you are involved in, you must repeat steps 2 through 5 for each participant of the
conference.

You must have an active connection to the other caller to transfer a file.
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How a User Receives a File
Video VoxPhone GOLD displays the File Transfer Receive window on the recipient's machine. This
window gives the recipient the opportunity to accept or reject the file. When the recipient accepts the
file, it is sent. The status of the file transfer is displayed under Current Status window.

Receiving A File
You can receive a file from another Video
VoxPhone GOLD user while a call is
established. To receive a file:
1. In the File Transfer Receive window,
select Accept to authorize the file transfer.
Alternatively, you may select Reject to
refuse the file.
2. In the Save As window, choose the
directory where you would like to save the
file and the name of the file to save.
3. Click on Save.

To interrupt the file transfer at any time,
click on Abort.

Ending A Call
Similar to a conventional phone call, when you have finished with a Video VoxPhone GOLD call, you
just hang up. To do this:

1. From the main Video VoxPhone GOLD window, highlight the session you want to end.
2. Click Hang Up.

Video VoxPhone GOLD removes the call from the Session list. If the call is a conference call, you are
removed from the conference, however the other participants in the conference call remain connected
to each other.
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Advanced Settings

Changing Your Sound Settings In The Main Menu

Microphone Sensitivity and Speaker Volume
During the conversation, you can adjust the sensitivity of the microphone and the speaker volume by
adjusting the sliders in the main menu, if you have enabled Audio Controls from the View Menu.

To enable the Audio Controls from the View Menu:
1. From Video VoxPhone GOLD’s main screen, select View.
2. If there is a checkmark next to Audio Controls then you already have them visible from the main

screen. If there is no checkmark, select the Audio Controls option, to activate the audio sliders.

Setting the Voice Activation Level
The Voice Activation level adjusts the volume at which your voice is sent.

When Automatic Gain Control (AGC) is
on, Video VoxPhone GOLD automatically
controls the Voice Activation level and
therefore does not display the yellow

triangle in the Audio Control area of the main Video VoxPhone GOLD window.

To set the Voice Activation Level:
1.  Place a call to yourself.
2.  Speak into the microphone. As you speak, you should see a horizontal bar to the right of the
     microphone icon. Notice how the length  and color of this bar changes with the volume level
     of your voice. This bar is called the recorder level bar.
3.  Adjust the Voice Activation level slider (the yellow triangle) so that you stop transmitting
     when you stop speaking, but low enough that you start transmitting when you start to speak.
     The Status column in the Session list displays “Xmit” when you are transmitting.
4.   Continue speaking. The recorder level bar should extend well past the Voice Activation
      level. If the recorder level bar does not extend past the Voice Activation level, move the
      Voice Activation level slider to the left.
5.   Stop speaking. If your microphone is very sensitive, background noise will trigger the
      microphone. If this occurs, the recorder level bar will extend past the Voice Activation
      level even when you are not speaking, so move the Voice Activation level slider to the right.

Turning the Microphone Or Speaker On/Off
Click on the microphone or speaker icon
to enable or disable the microphone or
speaker.
*  The microphone is on by default.

*  When the microphone is off, even if you have an active session, your voice will not be transmitted.
*  The speaker is on by default.
*  When the speaker is off, even if you have an active session, speech that is transmitted to you will
    not be heard through your speakers.
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A red circle with a slash through it appears over the microphone or speaker icon when either one is
tuned off.

Finding My IP Address
Video VoxPhone GOLD allows you to view your Internet Protocol (IP) address in the Network
Information window. If you do not publish your name in an online directory, other users cannot look
up your IP address. The Network Information window allows you to view your IP address and decide
whether to give it to others.

To See Your IP Address:
1. From the Video VoxPhone GOLD main menu , select Tools then click on Network

Information.
2. When you finish viewing the information, click on OK.

PC-To-Regular Phone Calls
Video VoxPhone Gold 2.0 will automatically load Net2Phone to make a call from your computer to a
regular telephone. Video VoxPhone GOLD does not make the call. Net2Phone is a completely
separate program, developed by Net2Phone.

Unlike PC-To-PC calls which are carried exclusively over the Internet, when you make a call to a
regular telephone, you are going over both the Internet and the regular telephone system. Long
distance charges may apply to calls placed over the phone system. There are no long distance
charges for making calls exclusively over the Internet, through a PC-To-PC connection.

For instructions on placing calls from your computer to a regular phone and any related long distance
charges, please contact Net2Phone toll-free at 1-800-438-8879, or visit their website at:
www.net2phone.com.

About The Online Directories

Type Of Online Directories
An online directory contains a list of users currently connected to one or more servers. Video
VoxPhone GOLD can connect you to several servers. Depending on how you set up your Directories
options, these connections allow you to view a large number of users. The following are the types of
online directories you can access:
♦ Video VoxPhone GOLD Online Users List. This directory lists published Video VoxPhone

GOLD users retrieved from one or more Video VoxPhone Online Users List directory servers.
The names are only displayed in the Online Users List in the Video VoxPhone GOLD application.

♦ Four11’s Video VoxPhone Users Directory. This directory lists published Video VoxPhone
users only (unless a user’s name is unlisted). The names are displayed on webpages on Four11’s
website.

All PC-To-Phone services are provided by Net2Phone. If you experience any
difficulties with the PC-To-Phone plug-in, please contact Net2Phone customer support
toll-free at 1-800-438-8879
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♦ Four11’s Global (H.323) Net Phone Users Directory. This directory lists published Video
VoxPhone and other standards-based H.323 phone users. The names are only displayed in
webpages on Four11’s Web site.

Publishing in Multiple Directories
As a Video VoxPhone GOLD user, you can publish your name in one of the Video VoxPhone Online
User List directories and the Four11 web directories. To view your directory options, from the main
screen select Tools then click on Options. Now select the Directories tab.

Selecting Directories for Publishing User Information
You select one or more online directories in which to publish your name in your Directories options.
These directories become your default directories. Video VoxPhone GOLD automatically publishes
your name in those directories when you start Video VoxPhone GOLD, unless you indicate otherwise.

You can only publish your name in one Video VoxPhone Pro directory at a time. You cannot publish
in multiple Video VoxPhone Pro directories.

Video VoxPhone Pro vs. Four11 Directories
Publishing in a Video VoxPhone Pro directory causes your name to be displayed in Video VoxPhone
Pro’s Online Users List. Publishing in the Four11 web directory causes your name to be displayed in
Four11’s web-based directories (unless your name is unlisted).

Please note, as we are phasing out VoxPhone Pro (all versions) we do not recommend using the
VoxPhone Pro directories.

Web-Based Calls
Using Video VoxPhone GOLD there are several ways to place calls with your web browser. Once set
up, you can make a web-based call by launching any of the following:

♦ A link placed on a webpage created with HTML code, where the link references a .TVX file
♦ A link listed on a webpage created for Video VoxPhone directory services
♦ A .TVX file on your local PC

For further information on web-based calls, please refer to the "Web-based calls" in the Help menu.
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Frequently Asked Questions

(i) What's the Difference Between Full-Duplex and Half-Duplex?
In full-duplex, you can transmit and receive voice simultaneously, just like a regular telephone. In half-
duplex, you can either transmit or receive voice data.

In half-duplex, you switch back and forth between talking and listening. Full-duplex allows you to talk
and listen at the same time.

In order to use the full-duplex capability of Video VoxPhone GOLD , your soundcard and audio drivers
must support full-duplex audio.

(ii) How Can I Tell If My Soundcard Supports Full-Duplex?
In order to use full-duplex both your soundcard and audio driver combination must support full-duplex
audio.
1.  End all active sessions.
2.  From the main Video VoxPhone GOLD menu, select  Tools then click on Options.
3.  Click on the Audio tab.
4.  From the Microphone list, select a soundcard driver.
5.  From the Speaker list, select a soundcard driver.
6.  If the Full-Duplex checkbox is grayed out, it is likely that your driver combination does not
     support full-duplex mode. Check the documentation of your soundcard for more information.
7.  Click on OK.

(iii) Who Can Receive Voice-Mail?
Because voice-mail is sent via Internet mail servers, anyone who has an Internet email address can
receive voice mail. The setup of the receiving person’s PC determines the voice message parts that can
be accessed.
Setup for Voice Messages:
To play and hear voice messages, the person’s PC should be set up to play sound. This means that the
person should have a PC, soundcard, and speakers that are set up and in working order. The PC must
also have a helper application set up that is capable of playing a .VOX file, which is the voice message
file format.
Setup for Text Messages
Anyone who has an Internet email address can receive a text message. We recommend that if a
person’s PC is not set up to play sound, only send them a text message.

(iv) How Do I Sort the Calling Directory?
Sort Mode
You can easily sort information in the online users directory or address book by left-mouse clicking on
a column heading. When the column heading button is pressed down, the column is in sort mode. When
a column is in sort mode, Video VoxPhone Gold alphabetizes the list beneath that column.
Toggle Mode
You can toggle the column heading button to display the user information column you want.
Sorting by Last Name
You can sort the list of user names alphabetically by first name or last name. To sort by last name, you
must first toggle the column heading to the Last, First column heading and then sort the list.
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Troubleshooting

Microphone Problems
If you are unable to transmit your voice using your computer's recording/microphone system, check the
following items to determine the cause of the problem:
1. Ensure the microphone is properly connected.

   *  Ensure the microphone is plugged into the computer.
   *  Ensure the microphone is plugged into the correct port.
   *  If your microphone uses a separate power supply, ensure that it is connected.

2. Ensure the volume is turned up.
   *  Turn up the volume on the microphone or its amplifier as needed.
   *  Turn up the microphone input volume in the Windows multimedia sound system.
   *  Ensure that any microphone mute switches are off.

Audio Speaker Problems
If you are unable to hear sound from your speakers, check the following items to determine the cause of
the problem:

* Ensure your speakers are properly connected to your soundcard.
 * Ensure the speaker volume is turned up.
 * Ensure Video VoxPhone GOLD's Speaker Volume is turned up.

Cannot Hear Anything
If you can establish a call, but you cannot hear anything, here are some potential solutions:

*  Verify that your speakers and microphone are operational. (You can test your speakers  
    and microphone with the audio application shipped with Microsoft Windows.)
*  Increase the speaker level on the main Video VoxPhone GOLD window.

                   (Drag the speaker volume slider toward the right.)
*  Use Video VoxPhone GOLD in half-duplex mode by clearing the Full-Duplex checkbox

       on the Audio Tab in the Preferences window. You can only change this checkbox when
                    you are not on a call.

Callers Cannot Hear Me
If you can hear others on a call, but they can’t hear you, check to see if your microphone is set up
properly. If your microphone level is too low and/or your Voice Activation level is too high, your voice
will not be transmitted.

The best way to test your microphone setup is to call yourself.

You can tell if your voice is being transmitted if you see “Xmit” or "Xmit/Recv" in the Status column
of the Session list when you speak.

Turning Off Microphone Amplification
If Video VoxPhone Gold seems to be unable to switch between Talk and Listen modes, you may need
to modify a microphone setting. This problem may appear as if you are always talking (even though
you are not) or always listening—and never switching modes.

If you always seem to be listening, the other party needs to turn off the amplification of their
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microphone. If you always seem to be talking, turn off the amplification of your microphone. Consult
the documentation of your soundcard and audio drivers for procedures on turning off the microphone
amplification.

Audio Sounds Choppy
Occasionally voices can sound choppy or garbled when you are on a call.
Possible causes:

*   Too many applications running on your system.
     To improve the performance, close the other applications while you are using   
     Video VoxPhone GOLD.
*   Connecting to the Internet through a firewall.
     If any parties are behind a firewall, all parties should connect to the Internet with a dial-up
     modem, instead  of going through a firewall. After reconnecting, start Video VoxPhone

                     GOLD again and re-establish your call.
*   Increase the Playback Delay setting.

Half-Duplex: Cannot Switch Between Talk and Listen Modes
If Video VoxPhone GOLD is unable to switch between Talk and Listen modes when using half-duplex
with Hands Off enabled, one of two problems may be occurring:

*  The Talk indicator is always on. This makes it appear as if you are always talking, even if 
    you are not.

               *   The Listen indicator is always on. This makes it appear as if you are always listening,
                    even when you are actually talking.

These symptoms can be caused by a low Voice Activation level or an amplified microphone 
on either party's system.

If you always seem to be talking, you need to do one of two actions:

*  Set the Voice Activation level
*  Turn off the microphone amplification

If you always seem to be listening, the other party on your call needs to perform these actions on their
machine.

PC-To-Phone Problems
PC-To-Phone support is provided by Net2Phone, not E-Tech Canada. For all questions and comments
about calling from your computer to a regular telephone please call the Net2Phone customer service
center toll-free, at 1-800-438-8879.
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TECHNICAL SUPPORT

NO busy signals.
NO line ups.
NO hassles.
NO problem!

E-Tech Canada provides the best technical support, period. We provide technical support on all of our
full releases. We do not provide technical support on free trial versions, demo versions, or BETA-test
versions.

If you encounter problems with Video VoxPhone GOLD, please follow these steps:

1. First, please READ THE USER’S GUIDE. Sounds simple, maybe even redundant, but most
questions can be easily answered by checking with the documentation which came with your
software. Our technical writers have spent literally thousands of hours, painstakingly going
through each and every aspect of our software, documenting how to install, configure and use the
software in plain and simple language.

2. After checking the User’s Guide, if you still can’t find an answer to your question, please
CHECK THE VOXPHONE WEBSITE.  Occasionally we release patches, updates and
revisions to our Frequently Asked Questions (FAQs), User’s Guides and other documentation.
The VoxPhone website is www.voxphone.com. It is a good idea to periodically check the
VoxPhone website for patches, new releases and new products.

3. If you still haven’t found the answer to your question, please contact us. The VoxPhone Support
team is here, for you. You can reach the VoxPhone Support Team in the following ways:

By E-Mail:  support@voxphone.com

By Voice-Email:  support@voxphone.com

By Phone:  1-(905)479-9419 (Monday to Friday, 9am to 5pm Eastern Standard Time)

All PC-To-Phone calls are made through
Net2Phone , please contact them if you have any
questions or comments regarding this service.
You can reach them toll-free at 1-800-438-8879.
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Important Points to Note

1. Before starting Video VoxPhone GOLD, you should be connected and online with your Internet
Service Provider or Internet Telephone Service Provider.

2. After you have installed the software into your computer, you should go through and complete the
Setup Wizard. This is very important because it helps you verify essential system components
and to optimize your system performance. Refer to page  12 of this manual.

3. The set-up procedures are simple and easy, just follow the instructions step-by-step.

4. You can customize your Video VoxPhone GOLD at any time through your options setting as
mentioned on page 22 of this manual. You can also enable and disable some features in the Phone
menu. Please refer to page 27.

5. After you have completed the Setup Wizard, the Main Menu will appear in the screen. Then you
are ready to make and receive calls.

6. Unlike normal telephone conversations, Internet telephony has short delays on the transmission of
your voice to the receiving party. You may have to wait a few seconds before receiving a response
from the other party.

7. You can adjust the sensitivity of the microphone and the volume of the speaker any time during a
conversation. This allows you to get the best outgoing sound quality.

8. Please pay attention to the small yellow triangle which indicates the voice activation level. This
small triangle is under the microphone sensitivity control. If you are working in full-duplex mode,
move this triangle fully to the left. If you are working in the hands-off mode, you should adjust the
"Voice Activation Level" very carefully. Please study the setting of the Voice activation level
section on page 42.

9. Different Internet telephone software applications use different codecs. Video VoxPhone GOLD
supports several codecs. Among all codecs,  RT28 uses the high quality 8KHz Meta Voice codec
and delivers excellent sound quality. It only operates on Video VoxPhone GOLD.  RT29 V.20
requires more system sources but delivers ultra high sound quality. To achieve the best results, the
other party should also use Video VoxPhone GOLD with the same codec. You can check the
codecs used by the other callers by clicking on the Time  column in Video VoxPhone GOLD main
window. (Please refer to page 25 of this manual for details on codecs).

10. Video VoxPhone GOLD allows you to call any user in the Video VoxPhone online user list. You
can also make a direct call to any user by entering his/her email address or Internet Protocol (IP)
address. You can also go to Four11 or other web-based directories to select and call a user. Please
refer to page 23 & 44 of this manual for details.

11. All PC-To-Phone calls are made through Net2Phone, please contact them if you have any
questions or comments regarding this service. You can reach them toll-free at 1-800-438-8879.

Your soundcard must support "full-duplex" audio if you want to use full-duplex mode. Video
VoxPhone GOLD can detect and indicate whether your soundcard supports full-duplex
audio. Please refer to page 14 of this manual.

If your soundcard does not support full-duplex audio, you cannot listen and talk at the
same time. You can either speak or listen at a time, just like a walkie-talkie does.
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